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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
MPLAB® Code Configurator. Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Revision History

DOCUMENT LAYOUT
This document describes how to use the MPLAB® Code Configurator to generate 
peripheral driver code. The document is organized as follows:
• Chapter 1. “Overview” 
• Chapter 2. “Installation” 
• Chapter 2. “Getting Familiar with the User Interface” 
• Chapter 3. “Operating the MPLAB® Code Configurator” 
• Appendix A. “Support ”

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
DS40001725B-page 4  2013-2014 Microchip Technology Inc.



Preface
CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

 2013-2014 Microchip Technology Inc. DS40001725B-page 5
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RECOMMENDED READING
This user’s guide describes how to use MPLAB® Code Configurator. Other useful 
documents are listed below. The following Microchip documents are available and 
recommended as supplemental reference resources.

http://www.microchip.com/mcc
DS40001725B-page 6  2013-2014 Microchip Technology Inc.



Preface
THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 
debug express.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART® Plus and 
PICkit 2 and 3.
 2013-2014 Microchip Technology Inc. DS40001725B-page 7
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CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: 
http://www.microchip.com/support.

REVISION HISTORY

Revision A (October 2013)
This is the initial release of this document.

Revision B (May 2014)
Updated Figures 3-7, 3-8, 4-3, 4-6, 4-7; Other minor corrections.
DS40001725B-page 8  2013-2014 Microchip Technology Inc.
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Chapter 1.  Overview
1.1 INTRODUCTION
The MPLAB® Code Configurator (MCC) is a user friendly plug-in tool for MPLAB® X 
IDE which generates drivers for controlling and driving peripherals of PIC® 
microcontrollers, based on the settings and selections made in the Graphical User 
Interface (GUI). The generated drivers can be used in any application program.
Before starting MCC, a new MPLAB X IDE project needs to be created or an existing 
project needs to be opened. This is necessary as MCC needs to know the device used 
in the application, to have access to device-specific information like registers, bits and 
configurations and also to setup its GUI. MCC generates source and header files based 
on selections made in the GUI. It adds the generated files into the active project of 
MPLAB X IDE.
Figure 1-1 shows an overview of working of the MCC for generating peripheral drivers.

FIGURE 1-1: WORKING OF MPLAB® CODE CONFIGURATOR

MCC
 2013-2014 Microchip Technology Inc.   DS40001725B-page 9
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Chapter 2.  Getting Familiar with the User Interface
2.1 OPERATING AREAS
MCC user interface consists of the following three main operating areas, see 
Figure 2-1.
• Resource Area: It displays the MCC supported peripherals that are available in 

the selected device. Includes both selected Project Resources and a list of possi-
ble Device Resources.

• Composer Area: It is the main area in which a peripheral can be configured. It 
displays the possible configurations of the peripheral.

• Pin Manager Area: The I/O pins of the device can be configured in pin manager 
in Table view. It also displays the pinout of the device and their functions as a 
Package view.

FIGURE 2-1: MCC GUI WITH DIFFERENT OPERATING AREAS

2.1.1 Resource Area
It is further divided into two sub-windows:
• Device Resources area, and
• Project Resources area

2.1.1.1 DEVICE RESOURCES AREA

The Device Resources area lists all supported peripherals of the selected device from 
where they can be included into the project resources. Once a peripheral is selected, 
it is moved to the Project Resource area, simultaneously invoking the pin manager with 
associated I/O pins of that peripheral.
 2013-2014 Microchip Technology Inc.   DS40001725B-page 10
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FIGURE 2-2: DEVICE RESOURCES AREA

The device resources tree can also be navigated and handled by using the following 
keys:
• Up and down arrow keys: For moving up and down in the tree, respectively.
• Right arrow key: For expanding a node.
• Left arrow key: For collapsing a node.
• Space key: For enabling a module if it is not a node or expanding or collapsing a 

node.

2.1.1.1.1 Peripheral Search Feature
MCC supports peripheral search in the Device Resources area. There’s a search bar 
and any available peripherals can be based on their name or application use.
• Based on peripheral name: 
Entering a few characters of the peripheral name in the search tab and pressing enter 
key lists all peripherals having those characters in their name. For example, see 
Figure 2-3 where the search has been done using a few characters of the peripheral 
name (“tim” for timers).

FIGURE 2-3: PERIPHERAL SEARCH BASED ON ITS NAME
 2013-2014 Microchip Technology Inc.   DS40001725B-page 11
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• Based on peripheral application: 
Entering the application name in the Search tab and pressing enter key lists all 
peripherals related to that particular application. For example, see Figure 2-4 where the 
search has been done using “motor control” keyword. This lists all the peripherals 
related to motor control applications.

FIGURE 2-4: PERIPHERAL SEARCH BASED ON ITS APPLICATION: 
MOTOR CONTROL

2.1.1.2 PROJECT RESOURCES AREA

The Project Resources area consists of a list of enabled peripherals selected from the 
Device Resource area. For configuring, click the peripheral name. The corresponding 
peripheral GUI gets displayed in the Composer area from where the selected 
peripheral can be configured.

FIGURE 2-5: PROJECT RESOURCES AREA

A module in the Project Resources window can be disabled by right clicking it and 
selecting the “Disable Module” option or by clicking the “x” button against it. Disabling 
a module will remove it from the generated files and the respective module 
configurations will be lost.
DS40001725B-page 12    2013-2014 Microchip Technology Inc.
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2.1.2 Pin Manager Area
The pin manager area consists of the following two sub areas: 
• Package or graphical view which shows the graphical package of the device, 

see Figure 2-6 and,
• Table view which shows the tabular form of pin manager, see Figure 2-7. 
I/O pins of the selected device can be configured from these windows.

2.1.2.1 PACKAGE VIEW

The graphical pin manager can be zoomed in and out in order to adjust its visibility. This 
can be done by holding down the CTRL key and scrolling the mouse wheel. Also, 
hovering over a selected pin shows the real-time configuration of that pin. The 
functionality of a pin can be selected by right clicking it in the package and selecting the 
desired functionality among the listed ones.

FIGURE 2-6: PACKAGE VIEW OF THE PIN MANAGER

The following color combinations are associated with the pins in graphical view:
• Grey colored pin: It indicates that the pin is not usable in the selected 

configuration and that there is no enabled module which has any functionality on 
that pin.

• Blue colored pins: It indicates pins which can be allocated to a module for 
configuration.

• Green colored pin: This combination indicates that the pin has been allocated 
and selected for a module. The name displayed against the pin is either the name 
of the pin in the module’s context or a custom name entered.

• Yellow colored pin: It indicates the pin currently being configured.
 2013-2014 Microchip Technology Inc.   DS40001725B-page 13
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2.1.2.2 TABLE VIEW

FIGURE 2-7: TABLE VIEW OF THE PIN MANAGER

The Package button allows the user to select between various supported packages, 
the selection made at which gets reflected in the graphical view of the pin manager.
The Reverse Pin Order button changes the port order of the I/O's. Clicking this button 
will switch between port pin ordering 0-7 or 7-0.

The three columns in the table view which indicate module name, functionality name 
and the port pin numbers, respectively, are movable and can be switched in between 
them for easier access.
Hovering over a cell with a lock shows the pins functionality in that module while it is 
not selected. However, when a pin is selected, it shows the name in that module or the 
custom name entered. Clicking on the “PORTx” title cell expands/collapses all the pins 
in that port. Also, right clicking anywhere in the “PORTx” row shows a menu to 
collapse/expand all the ports.
More features of the pin manager:
Right clicking in the pin manager area pops up a menu with the following options:
• Invert split panes: It is used to invert the split panes between the graphical and 

table views of the pin manager.
• Divider: It is used to change the divider between the graphical and table views of 

the pin manager to either horizontal or vertical types.
• Print: It is used to print the graphical or table view of the pin manager. If the table 

view is selected for printing, the currently selected table gets printed. Thus, for 
printing both the horizontal and vertical tables, the user should switch and print 
each view individually. 

• Export: It is used to save the package or the table view to an image file. The 
supported image formats are .jpg, .png, .gif and .bmp which along with the user 
defined name can be provided in the dialog which appears when this option is 
selected.

2.1.3 Composer Area
Once a peripheral is selected from the Project Resources area, its corresponding 
Configuration GUI is displayed in the Composer area. The Composer area is where 
a peripheral is configured based on application’s requirements.
DS40001725B-page 14    2013-2014 Microchip Technology Inc.
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2.1.3.1 INITIALIZERS

Initializers are the functions which are generated based on the module configuration 
set by user inputs and settings done in the GUI. The GUI supports multiple initializers, 
so any number of initializers can be generated for a module based on the application’s 
requirements. In the case of multiple initializers, each initializer GUI needs to be 
configured separately.
The Composer area has two main regions:
• Initializer specific area: It is the region which includes settings particular to the 

initializer. Any changes in the settings will be reflected in the generated 
configuration function. Visually, it is the area bounded by the black rectangle in the 
composer, see Figure 2-8.

The initializer specific area consists of an initializer bar from where an initializer can be 
added, removed, renamed or given comments. Clicking the “+” button adds a new 
initializer, whereas clicking “x” button removes the selected initializer. Also, the 
comment entered for an initializer is included in the generated code for the initializer.
• Global area: The region of the composer excluding the initializer specific area is 

treated as global area. It consists of settings which globally affect the module and 
thus all, initializers share these settings. 

FIGURE 2-8: COMPOSER AREA FOR EUSART MODULE

For example, if the EUSART peripheral is selected from the Project Resources area, 
the EUSART Composer area gets invoked, see Figure 2-8. The EUSART Composer 
area allows configuring different EUSART parameters related to transmission and 
reception operations. It also has fields to use peripheral interrupts as well as standard 
input-output (stdio) functions, which can be used depending upon the application 
needs. Once setting up of required peripheral configurations is done, clicking Generate 
Code will generate drivers for that particular peripheral. The Generate Code button 
gets activated only when there is something that needs to be generated (e.g., a new 
module) or when some changes have been done in an already generated module.
Hovering over the Generate Code button provides the list of modules which need to 
be generated or regenerated.
“Resources” and “Pin manager” buttons provide a link to those particular areas. Thus, 
if any of these areas are not in focus, they can be brought in focus by clicking these 
respective buttons.
Configuration of the operation of MCC can be managed by using the “Options” panel 
which can be invoked by clicking Tools -> Options -> Embedded -> MPLAB Code 
Configurator in the menu bar of MPLAB® X IDE.
 2013-2014 Microchip Technology Inc.   DS40001725B-page 15
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FIGURE 2-9: MCC OPTIONS PANEL

The MCC Options panel offers the following controls:

2.1.3.2 MCC FILE HANDLING

• Remove unused files from the project: Enabling this option tells the MCC to 
remove .c and .h files for modules which were removed from the MCC 
configuration between the subsequent generation procedures. This option 
ensures that the files which are included in the project (and thus in the 
compilation) are only those which are strictly necessary. However, this will not 
delete files from the disk.

• Delete unused files from the disk: This option gets enabled only when “Remove 
unused files from the project” is selected. This performs the additional task of 
deleting unused files from the disk and thus, files cannot be recovered anymore.

2.1.3.3 MCC DIALOGS

• Always ask before removing a module: Enabling this control enables the “are 
you sure?” dialog which appears while disabling or removing an enabled module.

•  Always ask before removing a pin: Enabling this control enables the “are you 
sure?” dialog which appears while deallocating or removing a pin from a 
peripheral.
DS40001725B-page 16    2013-2014 Microchip Technology Inc.
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Chapter 3.  Operating the MPLAB® Code Configurator
3.1 PROCEDURE FOR PERIPHERAL DRIVERS GENERATION
Figure 3-1 shows an overview of steps involved in generating peripheral drivers using 
MCC.

FIGURE 3-1: PROCESS OF CODE GENERATION USING MCC

Follow the steps to generate peripheral drivers using MCC in MPLAB® X IDE:
1. Create a new MPLAB X IDE project or open an existing project. As an example, 

a project for the PIC16F1937 device with the name example is created here, see 
Figure 3-2.

FIGURE 3-2: CREATING A PROJECT IN MPLAB X IDE

Create a new or 
open an existing 

project 

Set as Main 
project 

Open MC2 

Select peripheral 
from Device 
Resources 

Select peripheral 
from Project 

Resources 

Configure I/O pins 
via the Pin 
Manager 

Set up the 
peripheral via the 
Composer Area 

Click on the 
“Generate Code” 

Button 

MCC
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2. If multiple projects are open in MPLAB X IDE, set one as the main (active) project 
by selecting “Set as Main Project” in the MPLAB X IDE. For the active project, 
MCC automatically includes the generated driver files.

3. Open the MCC plug-in tool. For this, in the menu bar of MPLAB X IDE, go to 
Tools -> Embedded and click MPLAB® Code Configurator. Note that for MAC 
users the “Embedded” selection will be under the “Preferences” menu. This 
launches the MCC GUI.

FIGURE 3-3: OPENING MCC IN MPLAB X IDE

4. Clicking the system module in the Project Resources area invokes the 
Configuration bits setting GUI in the Composer area where device Configuration 
bits can be set, see Figure 3-4. The Configuration bit settings will be included in 
the generated code.

FIGURE 3-4: SETTING CONFIGURATION BITS IN MCC

The Configuration bits tree can be navigated and handled by using following keys:
• Up and down arrow keys: For moving up and down in the tree, respectively.
• Right arrow key: For expanding a node.
• Left arrow key: For collapsing a node.
• Space key: For setting a bit if it is not a node or expanding or collapsing a node.
5. From the Device Resources area, select a peripheral to be enabled for code 

generation. For example, EUSART asynchronous (NRZ) module has been 
enabled here, see Figure 3-5. Once a peripheral is enabled, observe that the 
peripheral now appears on the Project Resources area, see Figure 2-6. Also, 
pins in the Pin Manager area get invoked based on the enabled peripherals.
 2013-2014 Microchip Technology Inc.   DS40001725B-page 18



MPLAB® Code Configurator User’s Guide
FIGURE 3-5: ENABLING A MODULE FOR CODE GENERATION IN MCC

6. In the Project Resource area, select the peripheral which needs to be configured 
by clicking the peripheral name. Once a peripheral is selected for configuration, 
the configuration GUI for that peripheral comes up in the Composer area. For 
example, EUSART asynchronous (NRZ) module is selected for configuration 
and hence, the respective module configuration GUI is displayed on the 
Composer area, see Figure 3-6.

FIGURE 3-6: SELECTING A MODULE FOR CONFIGURATION IN MCC

3.1.1 GPIO Module
The order of the pins in the GPIO module GUI can be moved up and down by merely 
dragging and dropping them to the desired location. Also, for pins supporting Interrupt 
on Change (IOC), the corresponding parameters (e.g., enable/disable, IOCP, IOCN 
etc.) can be configured using the GPIO module GUI.
DS40001725B-page 19    2013-2014 Microchip Technology Inc.
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7. Configure the peripheral in the Composer area. As an example, assume that an 
application requires two EUSART initialization functions: one with a 1200 baud 
rate and the other with a 9600 baud rate. Multiple initializers can be generated 
for each baud rate required. Each initializer can be called as required by 
application. Multiple initializers can be added by clicking the “+” button present 
next to the initializer name in the Composer area. 

FIGURE 3-7: CONFIGURING MULTIPLE INITIALIZERS OF A PERIPHERAL 
IN MCC

Note that when multiple initializers are used only the default initializer, denoted by the 
small sprocket icon, will be automatically included in the global initializer function. 
Additional initializers must be called by the application when they are required.
If interrupts are enabled for a peripheral in its Composer area, an interrupt symbol gets 
prefixed to that peripheral’s name in the Project Resources showing the fact that 
interrupts have been used in its configuration. Also, an extra module called “interrupt 
manager” gets added in the project resources list which can be used to assign the 
interrupt execution priority for multiple peripherals.
8. Configure the pins in the Pin Manager area depending upon the application 

requirements. The table view can be displayed in either a vertical or horizontal. 
The package view displays the respective pin configurations graphically. For 
example, Figure 3-8 shows the 44-pin TQFP configurations for the EUSART 
asynchronous (NRZ) module which was enabled for configuration.
 2013-2014 Microchip Technology Inc.   DS40001725B-page 20
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FIGURE 3-8: CONFIGURING PINS USING PIN MANAGER AREA IN MCC

9. When all of the enabled modules have been configured, clicking the Generate 
Code button at the top of the Composer area will generate the drivers and 
initializers.

3.2 GENERATED PERIPHERAL DRIVERS
The generated drivers will be included in the active MPLAB X IDE project, see 
Figure 3-9.

FIGURE 3-9: GENERATED PERIPHERAL DRIVERS

These generated drivers consist of module configurations, pin configurations, interrupt 
configurations and system configurations.
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• The mcc.h and mcc.c files include the definitions of Configuration bits and the 
oscillator_initializer function. These definitions are based on the settings which 
were made for the System module in the Composer. Also included is the 
system_initializer function which can be called in the application program to call all 
the other default initializers (the ones marked in the GUI by sprocket symbol  ).

• The pin_manager.h and pin_manager.c files include the pin manager ini-
tializer functions based on the configurations which were made in the pin manager 
GUI.

• The interrupt_manager.h and interrupt_manager.c files are optional 
files which are generated only when peripheral interrupts are enabled and they 
include interrupt initializer functions. 

• The <peripheral_name>.h and <peripheral_name>.c files are module 
specific files and include each module’s peripheral configuration functions.

• The main.c file is generated only when the MCC detects that there is no 
main.c file present in the project. If there is any previous main.c in the project 
regardless of its creator (the user or MCC), it will not generate or overwrite the 
existing one. When using a main.c not generated by MCC the lines: “#include 
“mcc_generated_files/mcc.h”, and SYSTEM_Initializer() need to be added 
to the main.c file.

Functions present in these generated files can be called in the application program 
based on requirements.

3.2.1 Code Modification Tracking
One of the MPLAB X features which MCC utilizes is the “Diff Checking Tool”. The Diff 
Checking Tool prevents the MCC code generator from overwriting any modifications 
the user has made to an MCC generated file. When MCC detects a user modification 
to a file during generation, the Diff Checking Tool appears (Figure 3-10). The modified 
code is shown on the left, and the newly generated code is shown on the right. Navi-
gation buttons at the top let the user to quickly move between each of the detected 
modifications. An arrow along the center margin is used to choose which of the 
changes are copied into the newly generated code. Clicking on the arrow copies the 
user modifications into the newly generated code. Not clicking on the arrow causes 
MCC to replace the user modification with generated code.

FIGURE 3-10: DIFF CHECKING DISPLAY WINDOW

Note: The user must enable the peripheral and global interrupts in the application 
code using the respective macros defined in interrupt_manager.h file.
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Appendix A. Support 
A.1 ABBREVIATIONS USED
• MCC: MPLAB® Code Configurator
• IDE: Integrated Development Environment
• GUI: Graphical User Interface

A.2 SUPPORT
• For more information about MPLAB X IDE, please refer to the following link: 

http://www.microchip.com/mplabx

• For more information about MPLAB XC compilers, please refer to the following 
link: 
http://www.microchip.com/mplabxc
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